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Getting ready

e Forassistance and current information about all aspects of getting started with ProSeries software, click
the Help button on the ProSeries toolbar to open the Help Center or go to www.proseries.com/support.

o Forinformation about What’s New with ProSeries for the current tax year (such as form and calculation
changes) refer to the ReadMe files located in the Help Center.

e Changesinthe ProSeries System Requirements
Windows Vista increased to Service Pack 2 for recommended and minimum system requirements.
Windows 7 Professional or Ultimate added to recommended operating system requirements.
Windows 7 Home Premium added to minimum operating requirements.
64 bit operating systems are now supported in 2009 ProSeries software.

e Changesto the Internet Connection Requirements

Dial-up Internet connection is no longer supported. High-speed Internet connection is required for
both recommended and minimum Internet connection requirements.

e Fordetailed information about current System Requirements, go to www.proseries.com/sysreq.

Installing ProSeries software for stand-alone use

You install ProSeries software from files you download from ProSeries.com (via the Internet) or from a ProSeries CD.

1 Close all programs.
2 Ifyou’reinstalling from a ProSeries CD, insert the CD into the CD drive.

If you're installing from an .EXE file that you downloaded from ProSeries.com, start Windows Explorer, go
to C:\Temp, then double-click the .EXE file.

3 Inthe ProSeries Installation dialog box, select Install ProSeries Software.
Tip:If you're installing from a ProSeries CD and the ProSeries Installation dialog box doesn’t appear
automatically, go to the Windows taskbar, select Start, then select Run. In the Run dialog box, type x:\
CDSETUP (where x represents the letter of the drive containing the ProSeries CD), then select OK. In the
ProSeries Installation dialog box, select Install ProSeries Software.

4 Follow the instructions on the screen. Specific dialog boxes are discussed next.




5 If a System Warning dialog box appears, select Cancel, correct the situation(s) identified in the dialog box, Tip: If you see the ProSeries Installation dialog box, select Exit to return to the Windows desktop, then

then start the installation procedure again. start the ProSeries program by double-clicking the ProSeries shortcut icon. The Connected Customer Wizard
6 Inthe Software License Agreement dialog box, select I accept the terms of the license agreement if you will begin.

agree to accept all the terms of the ProSeries License Agreement, then select Next.

Important: If you find the terms of the License Agreement unacceptable, do not install the software. Troubleshootlng suggestlons

Select I do not accept the terms of the license agreement, then contact ProSeries Customer Service for a
refund instead.

7 Inthe Select an Installation Type dialog box, select Stand Alone, then select Next. ®  Start your Internet browser, then go to http://www.proseries.com to search for additional troubleshooting
solutions.

If you have difficulty installing or starting the ProSeries program:

8 Inthe Select Destination Directory dialog box, select Next to install ProSeries software in a \PROWINyy ) 4 o 4 ' 4
directory (where “yy" represents the last two digits of the tax year) on the drive that's shown in the dialog box. ®  Referto http://www.proseries.com/support for ProSeries Techinical Support contact information. To save time,

. ather as much information as possible, including any error messages.
Tip: If you want to install ProSeries software to a different drive or directory, click Browse. In the Select E P gany g

Folder dialog box, select the drive you want, type the folder name \ProWinyy in the Folder name field (where
“yy” represents the last two digits of the tax year) after the drive you selected, then select OK.
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9 Inthe Product Selections dialog box, select every ProSeries tax products that you expect to use, then select
Next.

Tip: If you used ProSeries software last year, products that were installed last year might already be selected.
Products you haven't purchased as unlimited will be installed as pay-per-return. You can install additional
products later, as described in “Keeping your ProSeries tax products up-to-date” on page 14. ® Firminformation. Retrieves the name and address of your firm.

The first time you start the ProSeries program, the Connected Customer Wizard helps you set up the program if
there’s a valid Internet connection.

R X ®  Product licensing. Licenses your ProSeries tax software to your firm.

This section explains how to E e R e—— ®  Product updates. Downloads and applies the updates for installed products, if any.
use this dialog box. j%‘ﬁ}'jf;’;;?:@fjﬁi ol ‘ ‘” “”5 1065 1041 " 1040 “é‘ﬂ “éﬂs ‘g5 ‘%‘ ® New products. Downloads and installs not-yet-installed products, if any.
ordertoses i they s | Ak B Mo [ . ) ] ) ) )
avalable for download. || 58 a |a ol oo Tip: If the computer doesn’t have a valid Internet connection, a dialog box asks if you want to start the Internet
s e ] i |4 E‘ 0o Connection Setup Wizard. Select Yes to establish an Internet connection, or select No to establish a valid Internet
These check boxes are for e Ei? H : H ﬁ HH E = connection at a later time.
federal products. Rt servercomnezions | BE oo [T i i
o from future CDs. g u u H g B
LA — City = . -
The check boxes o the right of i HH 2 a’g H Using the Connected Customer Wizard
the Federal Products section e ey D 5 @ o O M O )
are for state products. mm L E H . 0 1 Inthe Connected Customer dialog box, select Next.
KS d |4 . . " .
& u % 0 O 2 Enter or verify your Customer Number and the ZIP code in the Customer Information dialog box, then select
Tip: At least one federal 1041 b [F IR IR i Next.
product must be selected. If 75 M—Em?mugmh o U % 4 3 H H 0O
you select a state product, be g w4 v A ——— ®)
sure to select the fg% 9:252 "o O gl H @ (@ @ X
corresponding federal product. Organizer o H o 5 wi O Enter pour customer number and zip code. This infarmation
R picoat Tz nfurt. ey T e e gt
slip.
[ maok ][ mests |[ cancel | ProSeries Tax
An Intuit ProLine” Solution
Customer Nurmber. Ioooo000o1
10 If any of the products you selected aren’t available, you’ll see the Installation Note dialog box. Review the Connected ™ — These numbers should match the
) . i ) C SO0 TOZRCek: [ Customer Number and ZIP code that are
list of products that will be installed later, then click OK. ustomer printed in the Sold To: area of your
11 Review the information in the Installation Details dialog box, then click Next to install the ProSeries tax NOTE: I your shipping acdiess is cifferant than your biling packing slip.
products you selected that are available. ia'.:h’ii.i}'Llﬁaé"S"aﬂé‘?Eii'}?%é]?.iﬁ et
. . ) ) ) ) ) Seiess anyaurpasting AR Adifferent Customer Number and ZIP
Important: If you see the Installation Failed dialog box, click Help to find a possible solution, then click code might appear in the Ship To: area
Exit to exit the installation program. of your packing slip.
12 Restart Windows message. If you are prompted to restart your computer, do so.
If the installation program doesn’t resume, double-click the ProSeries shortcut icon on your <Back Newt > Cancel |
Windows desktop to start the ProSeries program. \E
13 Setup Complete. If you leave the check mark in the Launch ProSeries option in the Setup BaBaiies AR 3 Select Next after the Connected Customer Wizard finishes the setup tasks.

Complete dialog box, the Connected Customer Wizard begins when you select Finish. 4 Review the information in the Verify Firm Information dialog box carefully. ProSeries program prints this

information on all returns prepared by your firm.
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If the information is correct, select Yes. If the information isn’t correct, select No. Select Next, then go to Step
8 if you selected Yes or go to Step 5 if you selected No.

5 Enter or edit your firm’s name and address in the Enter Firm Information dialog box, then select Next.

6 The wizard transmits the updated information to an Intuit server, or a dialog box instructs you to call
Customer Service. Select OK to continue.

7 Review the firm and product information in the Product Licenses dialog box.

8 If the ProSeries Update program downloads and installs products and product updates, review the status of
each product ProSeries Update dialog box, then select Close.

When the Connected Customer Wizard or ProSeries Update program finishes, the ProSeries program starts. The first
time the ProSeries program starts, the Prior Year Settings Transferred dialog box appears if the program was able
to transfer the preferences and settings you used with last year’s program.

Important: The ProSeries Login dialog box opens if (and only if) you used the Access Rights feature in last
year’s ProSeries program and last year’s Access Rights information was transferred. Enter a valid User Name and
Password, then click OK to proceed.

Using the Options Setup Wizard

The Options Setup Wizard usually automatically runs the first time the program starts. If it does not automatically
start, click the Help button on the ProSeries toolbar then click Options Setup Wizard. The Options Setup Wizard
helps you set up ProSeries options. Most Options Setup Wizard dialog boxes are self-explanatory. Note the
following:

® Thesecond dialog box asks you to select Express Setup or Custom Setup.

o If youselect Express Setup, you see the Options Setup Wizard dialog boxes for the ProSeries options you
need to set before you complete returns.

o If youselect Custom Setup, you select the areas of the program you want to set up, then you see dialog
boxes for those areas of the program.

® When the Congratulations dialog box appears, select Finish to save the options that you selected.

You can set up E-File options and Bank Products Enrollment/Registration Information using the Options Setup
Wizard.

For more information about offering bankproducts through Santa Barbara Bank & Trust or Refund Advantage:
e Use the Search Help feature on the toolbar or in the Help Center, or

e Clickthe Help button on the toolbar, select User’s Guide then go to chapter 21, “Bank Products”.

The next sections discuss “Entering firm and preparer information” and “Entering global billing information” in some
detail.

Tip: Forinformation about a field in a dialog box, right mouse click the field, then select About <Field> on the
pop-up menu.

Entering firm and preparer information

If you completed the Connected Customer Wizard, you’ll see your firm’s name and address in the gray area of the
Firm Information section.

Enter other information about your firm in the fields below the gray area. If the firm will be filing returns
electronically, enter the firm’s Electronic Filing Identification Number (EFIN) and the name of the person that
ProSeries Technical Support can contact if necessary.
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Options Setup Wizard |§‘

During the product licensing procedure, Firm/Preparer Information
your firm’s name and address are Firm Information &
retrieved from an Intuit Internet server, e e =
then entered here. Adtress 1040 Main Street

City San Dieqp  Swme CA ZPCece 92122 0 0
Enter other information about your firm Empioyer 102 (1) mwmm
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. Fax Firm E-
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this section. Preparer I Electronic Return Originator (ERO) Information

[ Seanristen with Eem s 1 Drint nams in sinnabirs 2imz? [ ™
Tomove to new ﬁelds, press ENTER or To enter or modify your Firm Name and Address, click Edit. Enter other Firm Edit
TAB, or use your mouse. and Preparer information directly on this form Sdt...

<Back Next > Cancel | Hep |

Enter information about each of the firm’s preparers in the Preparer / Electronic Return Originator (ERO)
Information section of the dialog box. If preparers will be filing returns electronically, also enter ERO Practitioner
PIN, ERO Contact Name, and Electronic Filing Identification Number (EFIN) information in this section as
applicable.

Tip: If the ProSeries program transferred preparer information from last year’s program, just edit the information
as necessary.

Entering global billing information

Use the Global Billing Options dialog box to set the billing options that you want to use for all clients. If the
ProSeries program transferred global billing information from last year’s program, just edit the information as
necessary.

Options Setup Wizard X

This dialog box helps you set up:
Global Billing Options

Tax Preparation Fees
Use this form to sedect th NG Option(s) you woukd like to h:
clients. You may add or hange this information for any clent

Hourly Charges Biling Optians from withi the cée
1 Tax Preparation
Per Form Charges Fﬁj‘gﬁ'ﬂa -
tronic filing fee
LIRT application preparation fee {max $40)

Miscellaneous Fees and Adjustments

At

N o 1 N W N =

Discounts o
=
Sales Taxes .
B
Standard Paragraphs = =

< Back Next > Cancel Help

Transferring data from last year’s ProSeries client files

The first time you start the ProSeries program, you can transfer relevant data from last year’s client files to new
ProSeries client files for this year. If you used ProSeries software last year, select Yes to go to the Transfer window,
then do the five steps listed on the left side of the Transfer window.

Electronic filing. If last year’s return was marked for electronic filing, that selection is transferred to this year’s
return.

Important: If your firm will be filing returns electronically from more than one stand-alone computer, and each
computer is using the same EFIN, change the starting number in the DCN counter in the Electronic Filing section

Setting up the ProSeries program



of the Options dialog box in the ProSeries program on all but one computer before opening any returns. See “If
more than one computer will be using the same EFIN” on page 7.
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The Transfer Log dialog box opens when the ProSeries program finishes transferring client data. Review the
information, then select Close to go to HomeBase.

Filing returns electronically

ProSeries/Electronic Filing software is installed with ProSeries tax products that support electronic filing.
For detailed information about electronic filing:

®  Goto http://www.proseries.com, select Products, then select Electronic Filing, or
®  Usethe Search Help feature on the Help toolbar or in the Help Center, or
®  C(lickthe Help button on the toolbar, select User’s Guide in the Help Center, then go to chapter

20, “Electronic Filing.” ?

Establishing an Internet connection

To file electronically, the computer on which the ProSeries program is installed must be able to connect to the
Internet. If you don’t have an Internet connection, you must first sign up for service with an Internet Service
Provider (ISP). Once you have an ISP, go to the Help menu, select Internet Connection Setup, then follow the
instructions on the screen.

Setting up the ProSeries program for electronic filing
Take the following steps to set up the ProSeries electronic filing options.

1 Gotothe Help menu and select Options Setup Wizard.
2 Inthe first Options Setup Wizard dialog box, select Express Setup.

3 EFINs. In the Firm/Preparer Information dialog box, enter the firm’s Electronic Filing Identification
Number (EFIN) in the Firm Information section, and enter preparers’ Electronic Filing Identification
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Numbers (EFINs) in the Preparer Information section. After you enter an EFIN, complete the corresponding
Efile Contact Name fields.

PINs. PINs (Personal Identification Numbers) are used as electronic signatures. Enter each preparer’s PIN in
the ERO Practitioner PIN field. A Practitioner PIN is any five-digit code (except all zeros) chosen by each
preparer.

Important: The IRS requires that tax practitioners e-file individual income tax returns with Practitioner
PINs or taxpayer Self-Select PINs. Tax practitioners can’t submit a paper signature for e-filed returns by using
Form 8453 anymore. A redesigned Form 8453 is used only to transmit required supporting paper documents.

Options Setup Wizard |5|
Firm/Preparer Information
Phone Print phone aumber on returm? Yes [ No [] V]
Fax Firm E-mail -
For MM, MM, OR Firms Only: State |Di
Electronic Filing Only: Electronic Filing |demification # (EFIN) (Ses Help)
s Efile Contact Name (First) Last) a8
Enter the firm’s EFIN and ERO contact
information here Preparer | Electronic Return Originator (E ROQ) Information
®  Preparer Code Mssociated with Firm # 1 Print name in signature area? [ | &
Freparer Name Seff-employed? O]
Social Security # Freparer Tax [ # (FTIN)
Preparer E-mail Prim date on rewrn? O
’ Freparer Phone CAF &
Enter the preparer’s PIN here. Electronic Filing Only: (Se= Help for additional details) ERQ Practitioner PIN
| |Electronic Fiing | dentification # EFI) Ertter EFIN if not using Firm I
Enter the preparer’s EFIN on — | |l comaet e Fhen fas = x
thisline, if applicable. To enter o modify your Firm Name and Address. olick Edit, Enter ather Fim
and Preparer information directly on this ferm Ed
If you enter an EFIN, enter ERO
contact information on this line.
<Back [ MWews | Cancel | Hep |

4 Inthe Filing Client Returns Electronically dialog box, select Yes, some returns may be filed
electronically.

5 Complete the remainder of the Options Setup Wizard.

If more than one computer will be using the same EFIN

When ProSeries software is installed on a computer, the DCN (Declaration Control Number) counter is set at
“00001.” The program assigns that number to the first federal return that’s marked for electronic filing, then
increments the DCN counter by “1.” As each subsequent federal return is marked for electronic filing, the program
assigns the current DCN to that return, then increments the DCN counter by “1.”

Important: If your firm will be filing returns electronically from more than one non-networked computer, and
each computer is using the same EFIN, change the starting number in the DCN counter in the Options dialog box
on all but one computer before preparers start to transfer or prepare returns. By advancing the DCN counter
sufficiently on each “additional” stand-alone computer, each return marked for electronic filing will be assigned a
unique DCN. For example, advance the DCN counter to “01001” on the second computer, to “02001” on the third
computer, and so on.

Tip: If a computer will be using a unique EFIN, it’s not necessary to change the starting number in the DCN
counter for that computer.
To change the starting number in the DCN counter for a computer:

1 Go to the Tools menu, then select Options.
2 Select Electronic Filing in the left side of the Options dialog box.
3 Goto the DCN Counter field and increase the number.
Tip: The Options Setup Wizard also provides a way to adjust the DCN counter.

Filing returns electronically



Installing ProSeries software for network use

Installing and setting up ProSeries software for network use involves the following three steps:

®  Step 1: Install to this computer (ADMIN workstation)

® Step 2: Complete Licensing (Connected Customer)

®  Step 3: Install to other network computers (USER workstations)

Note that certain details vary from system to system. If you have additional questions about network installation:

1 Start your Internet browser, then go to http://www.proseries.com.
2 From the ProSeries.com home page, select Support.
3 Type aquestion in the Search the Knowledge Base field, then select Search.

Tip: If you want help optimizing ProSeries software on your network, your Network professional can go to http://
www.proseries.com, login to My ProSeries, then send an e-mail to ProSeries Technical Support.

Prepare your networked computer system

Before you can install ProSeries software, you must prepare your networked computer system. The specific steps
appropriate for your system depend on the type of network and the way it’s set up. The table below explains some
network-related terms.

Term Explanation

Client-server network A network setup where only one computer (the server) shares resources used by one or more
workstations (the clients).

Peer-to-peer network Up to 10 computers that are linked together. One or more systems may share resources.
Mapped drive Any drive or shared resource that has a drive letter assigned to it.

ProSeries ADMIN The computer from which ProSeries software is installed to the server or serving computer. You
workstation can designate any computer to be the ProSeries ADMIN workstation (including the network

administrator’s computer), but once you choose a ProSeries ADMIN workstation, it should
remain the ProSeries ADMIN workstation throughout the tax season.

ProSeries User A computer that runs the ProSeries program and accesses the ProSeries network components

workstation from the shared folder.

Shared folder The folder that is set up by the Network Administrator to be shared in the network system. The
ProSeries shared folder is the location where ProSeries network components and client files
reside.)

Primary file location This is the location where the program stores all current-year client files. This location can be

set only from the ProSeries ADMIN workstation.

For instructions related to shared folders, mapped drives, rights, and permissions, refer to the documentation for
your operating system and/or network software. If you have additional questions about preparing your networked
system for the network version of ProSeries, go to http://www.proseries.com, select Support, type a question in the
Search the Knowledge Base field, then select Search.

Take the following steps before you begin the ProSeries installation procedure.

1 Decide which drive on the server (if a client-server network) or the serving computer (if a peer-to-peer
network) you will install ProSeries shared network components.

2 Onthedrive you chose, create a folder named ProSeries.
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3 Make the ProSeries folder a shared folder, and assign it the name “ProSeries.”

4 Within the ProSeries folder, create a folder named ProNetyy (where “yy” represents the last two digits of the
tax year).

5 Decide which computer will be the ProSeries ADMIN workstation. Use the following information to help you
decide.

e Internet access. An Internet connection is required.

o If aclient-server network. You install ProSeries software from the ProSeries ADMIN workstation to the
server’s hard drive. The ProSeries ADMIN workstation and the server are two different computers. The
ProSeries ADMIN workstation can be used as a workstation, but the server is not used as a workstation
because doing so can degrade network performance.

o If a peer-to-peer network. You install ProSeries software on the ProSeries ADMIN workstation’s hard
drive.The ProSeries ADMIN workstation can be used as a workstation.

e Rights. The ADMIN workstation is the only computer that has rights to at least some aspects of the
following features: Product Updating, Customer Information, Primary File Location, Firm Name and
Address, Master Password, Electronic Filing Password, Bank Products Registration Information, Database
Maintenance, and HomeBase Tune-up.

6 Make sure a drive is mapped to the ProSeries folder on the server or serving computer. Make sure the
ProSeries ADMIN workstation has the appropriate rights and permissions.

7 Goto each computer that will serve as a ProSeries User workstation, then make sure a drive is mapped to the
ProSeries folder on the server or serving computer. Make sure each User workstation has the appropriate
rights and permissions.

Map drive factors to consider

We recommend you use mapped drives (rather than UNC), and that the drive with the ProSeries shared network
components be mapped to the same drive letter for all workstations.

Mapped to same drive letter. If you're an existing ProSeries network user and have all computers mapped to the
same drive letter, you don’t have to change anything. Install ProSeries software as you did in prior years.

Mapped to different drive letters. If all of your workstations are mapped to a network shared folder using
different drive letters, you don’t have to re-map the workstations.

New computers. If you're an existing ProSeries network user and you've added new computers to your network,
we recommend you set them up the same way as the existing workstations on your network.

New user. If you are installing ProSeries software for the first time, you can install ProSeries shared network
components directly to a shared folder without mapping drives. You can run the workstation installation and setup
from all other computers by accessing this shared folder.

UNC instead of mapped drives. UNC stands for “Universal Naming Convention” or “Uniform Naming
Convention.” UNC uses the following format:
\\server-name\shared-folder-path

If you use UNC instead of mapped drives, the shared folder doesn’t have to be mapped to a network letter as long
as all workstations can access the shared folder. However, if you use UNC instead of mapped drives, you must use
UNC exclusively.

Step 1 and Step 2: Install and set up ProSeries software from the
ADMIN workstation

Installing ProSeries software from the ADMIN workstation for network use is similar to installing ProSeries software
for stand-alone use with the following exceptions:
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1 Inthe Select an Installation Type dialog box, select Network, then select Next. 7 User workstation installation instructions. Click Print so you can refer to a printed copy of the instructions

2 When the Review Network Installation Steps dialog box appears, review the summary of the three steps while you are installing the softwared and setting up each user workstation.
required for network installation, then click Next.
3 Inthe Computer Name dialog box, enter a name for the current workstation (such as the name of the Step 3:Setu P each ProSeries User workstation

person who typically uses the workstation), then click Next. Installing ProSeries software to each workstation is similar to installing ProSeries software for stand-alone use with

4 Inthe Choose Destination Location dialog box, accept the recommended locations for the Local Folder the following exceptions:

and Network Folder unless:

F h ProSeries U kstation:
e Local Folder. You want the ProWinYY folder (where “YY” represents the last two digits of the tax year) on fomeacn Froseries Userworkstation

alocal drive other than C:\. 1 Go to the Windows taskbar, click Start, select Run, enter the path that’s identified in the User workstation

e Network Folder. If the suggested location isn’t appropriate or the Network Folder field is blank, select
the ProNetYY folder (where “YY” represents the last two digits of the tax year) within the ProSeries folder
that you created on the server or serving computer.

ProSeries 2009 X

Choose Destination Location ProSeries  Tax
An Intuit ProLine” Solution

{Profess

Select folders where setup will instal files

If you accept: If you want to

. ) select adifferent
The location @ Pl st el el e otz s local location, click

shown in the Local this Change

Folder ﬁeld,und\ button.

< The locati I~ Local Folder: (this computer)  Tell Me bore /

e location -

shown in the EAPuawinD3 If you want to

Network Folder enter or select a

field (if alocation is |— Network Folder: (shared data)  Tell Me Mors different network

shown), then CoProS srissPIoN st location, click this
\ Change button.

Click Next.

<Back || Mest> | [ Cancel |

If you accept the recommended folders, click Next and proceed to Step 5.
If you don’t accept the Local Folder:
a. Select the local drive where you want to install the ProSeries program.

b. Gotothe Path field, type ProwinYY (where you type the last two digits of the tax year in place of
“YY”) after the drive that you selected, then click OK. If you are prompted to create the ProWinYY
folder, click Yes.

c. Continue with Step 5.
If you don’t accept the Network Folder:
a. Select the drive where you want to install the ProSeries shared network components.

b. Gotothe Path field, then type “ProSeries\ProNetYY” (where you type the last two digits of the
tax year in place of “YY”) after the drive you selected, then click OK. If you are prompted to create
the ProSeries or ProNetYY folder on the drive that you’ve selected, click Yes.

c. Continue with Step 5.

5 When the Step 2: Complete Licensing (Connected Customer) dialog box appears, review the summary of

the next steps, then click Next.

6 Connected Customer Wizard. If the product licensing information that was downloaded by the Connected

Customer Wizard didn’t include a Network License. you'll see the Your Network License is Missing dialog
box.

e Select License Now then call Customer Service to resolve the issue, or
e Select Continue without licensing then click OK.

installation instructions, then click OK.

Tip: That path will probably be x:\ProSeries\ProNetYY\WKSTN\setup.exe, where x represents a drive on
your system (but not necessarily Drive X), and “YY” represents the last two digits of the current tax year.

& Type the name of a pragram, folder, document, ar This example shows a path that starts with Drive
Triternet resource, and Windows will open it For you. N

Cpen: | N:|ProSeries|ProletDBIwKS TN setup. exe vl

This field is not case sensitive.
Letters can be upper-case or lower-case.

o ][ cancel ][ eromse.. |

2 Follow the instructions on the screen.

3 Inthe Choose Destination Location dialog box, accept C:\ProWinYY as the recommended location for the
Local Folder, or select a different local drive for the ProWinYY folder (where YY represents the last two digits
of the tax year).

4 Inthe Computer Name dialog box, enter a name for the User workstation (such as the name of the person
who typically uses the workstation), then click Next.

5 The HomeBase Reconciliation dialog box appears if the ProSeries program detects that the HomeBase
database on the User workstation needs to be updated with the latest information in the client files stored
with the shared network components.

HomeBase Reconciliation

This progress bar keeps you FiaGeries has detected that your HomeBase view must be updated 1o reflect the latest elient information on the
informed about status of the etk Plesss wait whils Profisfiss prdatss pour HomeBsss visw

HomeBase Reconciliation “You should anly sxperisnce this wait when a large number of client files ars involved in HomeE ase Reconaiiation,
operation This process will alow Praeries to perfarm mere quickly in other impertant areas thioughout the season
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6 Network License. If the product licensing information that was downloaded by the Connected Customer
Wizard didn’t include a Network License, follow the instructions in the Network License Missing dialog box
to resolve the situation.

Important: You can’t print or e-file returns until your ProSeries software is licensed.

ProSeries Quick Reference Guide

Product licensing

Product licensing is a system that licenses your ProSeries tax software to your firm. Product licensing is required
before you can print returns, file returns electronically, or create PDF files that contain returns. Products that aren’t
licensed for unlimited use can be used on a pay-per-return basis.

Product licensing I



Product licensing uses your Customer Number and ZIP code with information in Intuit’s records to deliver the
following to your ProSeries tax software:

® Anunlimited-use license for each ProSeries tax product and ProSeries electronic filing product that you’ve
purchased for unlimited use—even if those products haven’t been installed yet

®  Yourfirm’s name and address

® Anetworklicense (if you purchased ProSeries/Network Version)

Tip: You can make minor changes to your firm’s name and address (such as changing “Dr.” to “Drive”) after

ProSeries product licensing has occurred.

ProSeries product licensing can be performed using the Online method or the Manual method. For most ProSeries
users, product licensing occurs online automatically.

Automatic, Online product licensing
The Connected Customer Wizard performs product licensing automatically when:

® Youinstall ProSeries tax software for stand-alone use on a computer that has an Internet connection

® Youinstall ProSeries tax software for network use from a computer (referred to as the ProSeries Admin
workstation) that has an Internet connection

Important: When ProSeries is installed for network use, product licensing must be initiated from the ProSeries
Admin workstation. Product licensing information is shared by all computers that have been set up as ProSeries
workstations. See the ProSeries Network Installation Guide for more information.

Be sure to read “Keeping your ProSeries tax products up-to-date” on page 14 of
this guide.

Product licensing using the Manual method

If automatic, Online product licensing hasn’t been performed (as explained above), you'll see the message
“Product Licensing Required” in the HomeBase Message Center. When you click that message, you see a License
Products dialog box that includes two options: Online (Recommended) and Manual. Select Manual, then select
OK. You'll see the License Products dialog box shown on the next page.

Tip: Ways that you can contact Intuit for manual product licensing include:

® Automated Touch Tone phone service (call 1-800-723-0692)
® Online service (go to http://www.proseries.com, then select Product Licensing)

1 License Products 3]

N 1. Verify C Numb d Zip Cod
Verify your Customer Number and ZIP code. ey s

Custorner Numer 0123956729 ZpCode [122
2
B 2. Enter Firm Inf i

Enter your firm’s name and address. e
(This information must match the information Fmio (]
contained in Intuit’s records.) pddess |
3 Ciy swe [ zpoode [
Contact Intuit using one of three methods. You will 3. Retrieve Activation Code

receive a unique Activation Code from Intuit.

To reiieve your activation code, you must contact Intuit using one of the methods below.

\ Eutomated Touch Tone: 1-800-723-0632

4 Oriine: i proseries.com/licensing

Customer Service: 1-800-374-7317
Enter the Activation Code, then click OK. e

oK Cancel Help
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Be sure to read “Keeping your ProSeries tax products up-to-date” below.

Product licensing with multiple, non-Internet computers

If you installed ProSeries for stand-alone use on computers that don’t have an Internet connection and you don’t
want to perform product licensing for each computer using the Manual method, here’s a convenient way to copy
your firm’s product licensing information from one computer to other computers.

1 From the computer with your firm’s product licensing information, go to the File menu, select Copy Product
License, then use the dialog box to save the product license file to a network location or removable media
(such as a 3.5-inch disk).

2 From each computer that requires product licensing, go to the File menu, select Retrieve Product License,
then use the dialog box to retrieve the product license file that you copied to the network location or
removable media.

Tip: Repeat this procedure if you update the firm’s product licensing information.

Updating your firm’s product licensing information

Update your firm’s product licensing information when:

®  You purchase additional ProSeries tax products or additional ProSeries electronic filing products for Unlimited
use, or

®  Youpurchase ProSeries/Network Version, or

® Thesoftware or an Intuit ProSeries representative instructs you to update your product license information

If either of these situations occur, go to the Tools menu, select License Products, select Online, select OK, then

simply wait for the product licensing procedure to conclude.

Tip:If the computer isn’t connected to the Internet, go to the Tools menu, select License Products, select
Manual, select OK, then follow the instructions in the License Products dialog box shown at the top of this page.

For more information about product licensing:

®  Usethe Search Help feature on the Help toolbar or in the Help Center, or Search

®  Clickthe Help button on the toolbar, select User’s Guide in the Help Center, then go to chapter 4,
“Setting Up ProSeries Features.” c@

Keeping your ProSeries tax products up-to-date

As soon as a ProSeries tax product or tax product update becomes available, it is posted to a ProSeries Internet
server. Getting products and updates via the Internet helps you have the most up-to-date versions of the tax
products you use.

Network: Most product updating activities must be performed from the ProSeries ADMIN workstation.

Task Scheduler

Use the Task Scheduler to Save time and never miss a critical update by scheduling selected tasks to run
automatically. Your computer must be runniing and connected to the Internet when tasks are scheduled to run

Using the Task Scheduler program

1 InProSeries, go to the Tools menu, select Options, then select Task Scheduler.

Keeping your ProSeries tax products up-to-date 13



2 Make sure the Download New/Update Existing Products task is enabled. Notes
3 To change the Task Scheduler schedule, select Modify.

Using the ProSeries Update menu

1 InProSeries, go to the Update menu and select Update Installed Products if you don’t want to select

additional products for installation.
2 InProSeries, go to the Update menu and select Select and Download New Products if you want to select

additional products for installation.
Tip: If ProSeries isn’t running, click the Start button on the Windows desktop, select Programs, select ProSeries,
then select ProSeries Update.

© 2009 Intuit Inc. All Rights Reserved. Intuit, the Intuit logo, ProSeries, Intuit ProLine, Quicken, QuickBooks, among others, are
registered trademarks of Intuit Inc. in the United States and other countries. Other parties’ trademarks and/or service marks are
the property of their respective owners and should be treated as such.
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